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Step 1

Accepting the assignment

Log in to the journal platform using the following username and
password.

e User: XXX
e Password: XXX

Username *

ptenjovillalba

Password *

Forgot your password? ¥ Keep me logged in

No account? Register here
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In the "My Assigned" tab, locate the article.

Submissions
My Queue | 1 Unassigned | 5 all active | 57 Archives | 1126 B Halp
My Assigned Q  Search T Filters Mew Submission
1572 Acosta - ™\ | i
Proof text “1 | 8 SubmEzion )| View || ~

Click on “View”.

Submissions

My Queue | 1 Unassigned | 4 All Active | 46 Archives | 2487

@ Help
My Assigned Q  Search T Filters New Submission
3135 Tenjo -
e =1 (O eroducion | View |~
Editorial v1 —
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On the “Submission” tab, download and check all the files, then
decide whether the article should be sent to peers.

3135 / Tenjo | Editorial vi Preview Activity Log Library

Workflow Publication

Submission \ Review Copyediting Production

Submission Review Copyediting Production
Submission Files Q search Upload File
* [ 31684 Revista prueba de texto.docx Fiy Article Text
(Reguired)
* [l 31685 Revista carta de sometimiento.docx FjY Article cover letter
* & 31686 Revistafigura 1.png FjY Figures
Download All Files
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Step 1

Make the initial editorial decision

If you decide to send the article to peers, click on “Send to Review”.

Submission accepted for raview.

Send to Review

Accept and Skip Review

Decline Submission

When the manuscript does not meet the journal's criteria, it should be
rejected by clicking “Decline Submission”.
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Submission accepted for review.

Send to Review

Accept and Skip Review

Decline Submission
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Step 2

Sending the manuscript to peers

Click on “Send to Review”.

Submission accepted for review.

Send to Review

Accept and Skip Review

Decline Submission

Select all the files you want to share with the reviewers (except the
submission letter).

Send to Review

Select files below to send them to the review stage.

Submission Files Q, Search Upload File

- @ 316e4  Revista prueba de texto.docx FinY Article Text

|Required)

W 31685 Rewista carta de sometimiento.doox

1686 Rewista figura 1.png

Send to Review Cancel
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Then, click “Send to Review”.

Send to Review

Here you have the option of changing the language.

Change Language

+ English

Espafiol (Espafia)

Edit Profile

Logout

To invite reviewers, click “Review” and then, “Add Reviewer”.

3135 | Tenjo | Editorial vi

Workflow Publication

Submission Review Copyediting Production

» & 31688 Revistafigura 1.png Fi Y Fig

Reviewers

Add Reviewer




ESSN SN0
(5N 100

X REVISTA DE LA
p : . 2 #¥ ACADEMIA COLOMBIANA
for associate editors Vis wW  de Ciencias Exactas, Fisicas y Naturales

Tutorial

Click the first or last name of reviewers from the platform's database in
the list displayed on the screen and then select the reviewer of your
choice.

Add Reviewer X

Locate a Reviewer Q,  Search T Filters

1active  José Manuel Gomez

Universidad Nacional de Colombia, Medellin Select Reviewer -~

0 Mever assigned Topologia Algebraica

lactive  Cesar Neyit Galindo Martinez
Universidad de Los Andes Select Reviewer  ~

0 2 days ago Categorias de fusian, Tecrias topoldgicas de campo

1active  Marie N. Nydam

Life Sciences Concentration, Soka University of America, USA Select Reviewer =~

0 5 days ago Biologia evolutiva, Tunicata

1active Rosana Rocha

English Select Reviewer

0 5 days ago Tunicada, Ascidiacea

1active Diego Gerardo Roldan
Universidad Nacional de Colombia Select Reviewer =~

0 & days ago

1active  Orlando O. Ortiz
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Add Reviewer X

Locate a Reviewer Q  Pablo Alexander % T Filters

Pablo Alexander Tenjo Villalba
Select Reviewer
1 1136 days ago

Create New Reviewer Enroll Existing User

Click “Select Reviewer”.

Add Reviewer

Locate a Reviewer Q,  Pablo Alexander ® T Filters

Pablo Alexander Tenjo Villalba

Select Reviewer

1 1136 days ago

Create New Reviewer Enroll Existing User

Click “Send”. An automatic message will be displayed on the screen
addressed to the evaluator. This message is editable and can be
adjusted as needed.

10
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Add Reviewer X

Selected Reviewer

Pabio Alexander Tenjo Villalba  Change

Email to be sent to reviewer
e B 7 Y &F & o B M
NAME :
I believe that you would serve as an excellent reviewer of the manuscript, "Editorial v1,"” which has been
submitted to Revista de |z Academia Colombiana de Ciencias Exactas, Fisicas y Naturales. The
submission's abstract is inserted below, and I hope that you will consider undertaking this important task

for us.

Please log into the journal web site by response puepate to indicate whether you will undertake the review

or not, as well as to access the submission and to record your review and recommendation.

The review itself is due review oue pate .

Submission URL: uaL

Thank you for considering this request.

Pablo Alexander Tenjo villalba
pablo tenjo@gmail.com

The response due date will appear in “Important Dates”.

Important Dates
2024-12-18 2025-01-01

Response Due Dote Review Due Date

If the reviewer accepts to evaluate the article, he/she will enter the
platform through the link that will be included in the invitation to accept
it and proceed with the online evaluation. The deadline for submitting
the evaluation is established in the invitation.

11
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2025-01-01

If you wish to search for the reviewer by subjects, click on the
corresponding one:

e Biomedical sciences

e Behavioral sciences

e Physical sciences

e Natural Sciences

e Chemical sciences

e Earth and space sciences
e Mathematics

Add Reviewer

Locate a Reviewer Q,  Physical sciences Y Filters

Ph.D. Ignacio Rodriguez-Iturbe
Princeton University Select Reviewer

0 3555 days ago

Zactive  Ph.D. JUAN CARLOS LOAIZA
Departamento de Geociencias y Medio Ambiente, Universidad Nacional de Colombia, 5¢ = Select Reviewer

1 1619 days ago

Dr.rer.nat. Angela Stella Camaho Beltran

Departamento de Fisica Universidad de los Andes Select Reviewer

i} Never assigned Fisica deMateria Condensada Nanociendia

Create New Reviewer Enroll Existing User

12
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Step 2

Adding peers to the database

If the reviewer is not listed in the platform database, enter his/her data
by clicking on “Add Reviewer”.

Add Reviewer

Reviewers

Then click “Create New Reviewer”.

79 Mext page

Create Mew Reviewer [ Enroll Existing User

13
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The following information will be requested by the platform.

e Name

e Username

e Emall

e Reviewing interests
o Affiliation

Add Reviewer

Back to Search

Create New Reviewer

Username *

Suggest

Reviewing Interests

Affiliation

Email to be sent to reviewer
hh & B 7 YU & 2

14
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The email message to be sent to the reviewer is editable.

Email to be sent to reviewer
M B B 7 Y & 22 o 3 M &

NAME

I believe that you would serve as an excellent reviewer of the manuscript, "Editorial v1,"” which has been
submitted to Revista de la Academia Colombiana de Ciencias Exactas, Fisicas y Maturales. The
submission's abstract is inserted below, and I hope that you will consider undertaking this important task

for us.

Flease log inta the journal web site by response puepate to indicate whether you will undertake the review

or not, as well as to access the submission and to recard your review and recommendation.
The review itself is due review ouepate .

Submission URL: ur

Thank you for considering this request.

Pablo Alexander Tenjo Villalba

pablo.tenjo@gmail.com

Once this information is provided, click “Add Reviewer”. The invitation
to the new reviewer will then be sent.

Add Reviewer

15
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In case the deadline for the review expires, click on “Send Reminder”.

Reviewers Add Reviewer

» Pablo Alexander Tenjo Villalba Overdue Anonymous Send
Response due: 2024-12-11 Reviewerfﬂnonymous .
Reminder
Author

The platform will display an editable template of the message to be
sent.

Review Reminder x

Reviewer

Pablo Alexander Tenjo Villalba <pablo.tenjo@gmail.com=

Email to be sent to reviewer

D B 7 Y L 2o Mo

MNAME &

Just a gentle reminder of our request for your review of the submission, " armicietimie " for revista peLa
ACADEMLA COLOMBIANA DE CIENCIAS EXACTAS, FISICAS Y NATURALES . We were hoping to have this review by ReviEw Due

oate , and would be pleased to receive it as soon as you are able to prepare it.

Submission URL: uRL -

Review Schedule
2024-12-12 2024-12-11 Y-m-d

M
o
=5
2
L]

r's Reguest Response Due Date

Send Reminder Cancel

16



55N N
SN T

® ’ ¢ ;
T u t oria I M ACADEMIA COLOMBIANA

for associate editors w4 de Ciencias Exactas, Fisicas y Naturales

To extend the review due date, click the “Reviewers” tab.

Reviewers Add Reviewer
» Pablo Alexander Tenjo Villalba Overdue Anonymous Send
Response due: 2024-12-11 Reviewerff-‘monymous .
Reminder
Author

Find the reviewer's name.

Reviewers Add Reviewer
v Pablo Alexander Tenjo Villalba Overdue Anonymous send
Response due: 2024-12-11 Reviewer,"ﬂnonymous
Reminder
Author
Review Details Email Reviewer Edit Unassign Reviewer History

Click on “Edit”.

Reviewers

¥ Pablo Alexander Tenjo Villalba Ov

Review Details Email Reviewer

17
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Modify the date.

Edit Review X

Impaortant Dates
2024-12-11 20241211

Response Due Date

Review Type
@® Anonymous Reviewer/Anonymous Author
O Anonymous Reviewer/Disclosed Author

C

© open

Files To Be Reviewed

Files To Be Reviewed Q search

B B 7 Revista prueba de texto.docx FiY

Revista figura 1.png Y Figures

Review Form
Formato de evaluacién v

OK  Cancel

Edit Review x

Important Dates
2024-12-11 2024-12-11

Response Due Date

Review Type
@ Anonymous Reviewer/Anonymous Author

O Anonymous Reviewer/Disclosed Author

3 December 2024 >

Open

y . Su Mo Tu We Th Fr sa
Files To Be Reviewed

Files To Be Reviewed 8 9 10 N 12 13 14

» B 31687 Revista prueba de texto.docx
22 23 24 25 26 271

Revista figura 1.png 29 30 3

Review Form

Formato de evaluacion v

OK  Cancel

Finally, click “Ok”.

OK [JCancel

18
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Step 3

Making the final editorial decision

How to send the evaluations to the authors

Enter the platform with your username and password

Usemame ™

ptenjovillalba

Password *

Forgot your password? ¥ Keep me logged in

No account? Register here

19



158!

2 SRR o
Tutorial ag mmas

de Ciencias Exactas, Fisicas y Naturales

for associate editors

The list of your assigned manuscripts will be displayed on the screen.

Click “View” to access the article whose evaluations are to be sent to
the author.

Submissions

My Queue | 1 Unassigned | 4 All Active Archives | 2491 o Help
My Assigned Q | Search T Filters New Submission
3135 Tenjo Villalba

Editorial v1 View

On the “Review” tab, access the reviewers' responses by clicking
“‘Read Review”.

Reviewers Add Reviewer

» Pablo Alexander Tenjo Villalba Review Submitted Anonymaus Read
Recommendation: See Reviewer/Anonymaous
Comments Review

Author

» Gerardo Tibana Review Submitted Anonymous Read
Recommendation: Accept Reviewer/Disclosed Author .
Submission Review

20
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The form completed by the reviewer will be displayed on the screen.
Check if the reviewer uploaded any file with comments in “Reviewer's
Files”.

Review: Editorial v1 X

Gerardo Tibana

I Completed: 2024-12-12 05:13 PM

I Recommendation: Accept Submission

1. Comentarios confidenciales para el editor *
Q

2. Comentarios para el autor

2.1. Calidad del resumen *
Q

2.2. Originalidad e importancia del articulo para el desarrollo en el campo del conocimiento *
Q

Read the evaluations, then click the “Request Revisions” tab to send
the evaluators' comments to the author.

Request Revisions

Accept Submission

Decline Submission

21
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An editable template to notify the author of the evaluations will be
displayed on the screen.

Request Revisions X

Require New Review Round
® Revisions will not be subject to a new round of peer reviews.
O Revisions will be subject to a new round of peer reviews.

Send Email
® send an email notification to the author{s): Pablo Tenjo
©' Do not send an email natification

hh B B 7 YU & 2 o i kW &

Pablo Tenjo:

We have reached a decision regarding your submission to Revista de la Academia Colombiana de

Ciencias Exactas, Fisicas y Naturales, "Editorial vi™.

Our decision is to:

+ Add Reviews to Email

Send to Reviewers

Send a co f this email notification by BCC to the fo his will reveal the author’s ide
reviewsrs,
[ Pablo Alexander Tenjo Villalba
[ Gerardo Tibana
Select review files to share with the author(s) Q search Upload File
» U b# 31687 = Revista prueba de texto.docx FiY
. k& 31688 | Revista figura 1.png Fi, Y Figures
» [ [# | 31885 = Revista prueba de texto_vi.docx Fj, Y

Record Editorial Decision = Cancel

22
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Then click “Add Reviews to Email”.

4+ Add Reviews to Email

In the case reviewers added documents, select them in “Select the
review files to share with the author(s)”.

Finally, click “Record Editorial Decision”.

Record Editorial Decision JCancel

23
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Step 3

Making the final editorial decision

Review the version corrected by the authors

Enter the platform with your username and password.

Usermame *

ptenjovillalba

Password *

Forgot your password? ¥ Keep me logged in

Mo account? Register here

24
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The list of your assigned articles will be displayed. Click “View”.

Submissions

My Queue | 1 Unassigned | 4 All Active Archives | 2491

© Help

My Assigned Q  Search T Filters New Submission
3135 Tenjo Villalba

Editorial v1 View

Then click the “Review” tab.

3135 [ [ Editorial v1

Workflow Publication

Submission Review Copyediting Production

In the “Review Files” section, check whether the author(s)’ sent the
following:

Review Files Q, search  Upload/Select Files

* [# 31687 | Rewvista prueba de texto.docx Fi Y Article Text
(Required)

* [& 31688 Rewista figura 1.png Fi Y Figures

25
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Check that the author has sent the following information:
e The corrected version (two copies, one indicating the changes
made and the other with the clean version).
e The letter of response to the reviewers
e The figures in individual files in JPEG format

Making the final editorial decision and informing the authors

If you agree with the changes made by the author, accept by clicking
“Accept Submission”.

Request Revisions

Decline Submission

26
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The platform will display an editable template to notify the author.

Accept Submission X

Send Email
® send an email natification to the author(s): Pablo Tenjo
O Do not send an email netification

& B 7 Y &£ &2 o XM

Pablo Tenjo:

We have reached a decision regarding your submission to Revista de la Academia Colombiana de
Ciencias Exactas, Fisicas y Maturales, "Editorial v1".

Our decision is to:

+ Add Reviews to Email

Send to Reviewers

Send a copy of this email notification by BCC to the following reviewers. This will reveal the author's identity to the
reviewers.

[ Pablo Alexander Tenjo Villalba

[J Gerardo Tibana

Select review files to share with the author(s) Q, Search  Upload File

» O W | 31687 Revista prueba de texto.docx Fi ¥ Article Text
[Required)

» [ B 31628 Revista figura 1.png Fi, Y Figures

L @ 31685 Revista prueba de texto vi.docx FieY

+ Select Library Files to attach

MNext: Select Files for Copyediting Cancel

27
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Select the latest files submitted by the author.

Select review files to share with the author(s) Q Search Upload File

» O [ 31687 Revista prueba de texto.docx Fir Y Article Text
(Required)

» O & 31682 Revista figura 1.png Fin Y Figures

4 [ 31883 Revista prueba de texto_v1.docx Fjo ¥

Accept Submission X

select the files you would like to forward to the Copyediting stage.

Revisions Q, search
> B | 20722 | versio November Article Text
1,2021
» [ | 20723 | car November Reviewsrs
1, 2021 response
letter

LRI Previous: Author Netification | Cancel

Finally click on Register Editorial Decision.

Record Editorial Decision

28
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Step 3

Making the final editorial decision

Open a second round of evaluation

Click on the “Request Revisions” tab.

Request Revisions

Accept Submission

Decline Submission

29
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This will record the editorial decision to proceed with the process.

Request Revisions %

Require New Review Round
@® Revisions will not be subject to a new round of peer reviews.
O Revisions will be subject to a new round of peer reviews.

Send Email
® send an email notification to the author{s): Pablo Tenjo

) Do not send an email natification

hh B B 7 ¥ & &2 o F M &
Gerardo Tibana:

We have reached a decision regarding your submission to Revista de la Academia Colombiana de

Ciencias Exactas, Fisicas y Maturales, "Editorial v1™.

Our decision is to:

<+ Add Reviews to Email

Send to Reviewers

f this email notification by BCC to the following reviewers. This will re the author's identity to the
Y g Y

| Pablo Alexander Tenjo Villalba
Gerardo Tibana

Select review files to share with the author(s) Q Search Upload File

» D W 31687 | Revista prueba de texto.docx FinY

o

» |= 31888 Revista figura 1.png Fj Y Figures
» [ [ 31639 Revista prueba de texto_vi.docx Fi. Y

Record Editorial Decision = Cancel

30
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Select all the files you wish to share with the reviewers (minus the
cover letter) and then click “Submit for Review”.

Select review files to share with the author(s) Q, search Upload File

v L W 31627 Revista prueba de texto.docx Fi, ¥ Article Tax
(Required)

» U = 31688 Revista figura 1.png FinY Figuras

L [ 31682 Revista prueba de texto_vi.docx Fi, ¥

Select the reviewers who evaluated the manuscript in the first round.

To invite them, click on the “Review” tab and then on “Add reviewer”.

Reviewers Add Reviewer h

31
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Click the first or last name of reviewers from the platform's database in
the list displayed on the screen and then select the reviewer of your
choice.

Add Reviewer x

Locate a Reviewer Q  Search T Filters

1active = José Manuel Gémez
Universidad Nacional de Colombia, Medellin Select Reviewer

0 Mever assigned Topologia Algebraica

1active  Cesar Neyit Galindo Martinez
Universidad de Los Andes Select Reviewer -~

0 2 days ago Categorias de fusion, Teorias topoldgicas de campo

1active  Marie N. Nydam

Life Sciences Concentration, Soka University of America, USA Select Reviewer  ~

0 S days ago Biologia evolutiva, Tunicata

1active Rosana Rocha

English Select Reviewer  ~

0 5 days ago Tunicada. Ascidiacea

1active Diego Gerardo Roldan

Universidad Nacional de Colombia Select Reviewer

0 & days ago

Tactive  Orlandeo O. Ortiz

32
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Click “Select Reviewer”.

Add Reviewer

Locate a Reviewer Q, Pablo Alexander X T Filters

Pablo Alexander Tenjo Villalba
Select Reviewer

1 1136 days ago

Create New Reviewer Enroll Existing User

Click “Send”. An automatic message will be displayed on the screen
addressed to the evaluator. This message is editable and can be
adjusted as needed.

Add Reviewer X

Selected Reviewer

Email to be sent to reviewer
& B 7 YU & &2 o

LY.
'y
(2
[+

NAME :

I believe that you would serve as an excellent reviewer of the manuscript, "Editorial v1," which has been
submitted to Revista de |z Academia Colombiana de Ciencias Exactas, Fisicas y Naturales. The
submission's abstract is inserted below, and 1 hope that you will consider undertaking this important task

for us.

Please log into the journal web site by response puepate to indicate whether you will undertake the review

or not, as well as to access the submission and to record your review and recommendation.
The review itself is due review pue pate .

Submission URL: urL

Thank you for considering this request.

Pablo Alexander Tenjo Villalba
pablotenjo@gmail.com

33
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The invitation that will be sent to the reviewer contains the
user keys,

the link,

the title,

the abstract

and the dates by which the reviewer must respond.

If the reviewer is interested in evaluating the article in the second
round, he/she will enter the platform through the link that will be
included in the invitation. The entire evaluation must be done online.

Once the invitation is accepted, the system will send a notification to
your e-mail.

34
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Step 3

Making the final editorial decision

Final editorial decision

Once the evaluation is received, the system will notify you by mail that
the evaluation is available.

Click on “Check details”.

Reviewers Add Reviewer

¥ Pablo Alexander Tenjo Villalba Review Submitted Anonymous Read
Recommendation: See Rev'lewer,n‘Anonymous .
Comments Review

Authaor

Review Details Email Reviewer Edit Cancel Reviewer History

A form will be displayed on the screen. Click on “Reviewer's score”
and then “Confirm”.

Reviewer rating

Rate the quality of the review provided. This rating is not shared with the reviewer

® No rating
O Yriririok
O ik
O ik

O ik

O

35
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Click on “Thank the reviewer”. An editable format for thanking the
reviewer will be displayed on the screen.

Authar
*  Gerardo Tibana Complete Anonymous Thank
Recommendation: Accept Reviewer/Disclosed Author .
Submission Reviewer
Revert
Decision

Thank Reviewer x

Reviewer

Gerardo Tibana <gerardo.tibana@scimago.es=

Email to be sent to reviewer

W B 7 Y &L 2o Bk

Gerardo Tibana:
Thank you for completing the review of the submission, "Editorial w1, for Revista de la Academia

Colombiana de Ciencias Exactas, Fisicas y Maturales. We appreciate your contribution to the quality of the
work that we publish.

O Do not send email to Reviewer,

Thank Reviewer Cancel
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If you feel that the manuscript should be accepted, click “Accept
Submission”.

Request Revisions

Accept Submission

Decline Submission

Select the latest updated files sent by the author and click “Next:
select files for Copyediting”.
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Accept Submission

Ssend Email
® Send an email notification to the author(s): Pablo Tenjo
) Do not send an email notification

B 7 Y & & o @ M 4

Pablo Tenjo:

We have reached a decision regarding your submission to Revista de la Academia Colombiana de

Ciencias Exactas, Fisicas y Naturales, "Editorial v1™.

Our decision is to:

+ Add Reviews to Email

Send to Reviewers

Send a copy of this email notification by BCC to the following reviewers. This will reveal the author's identity to the
reviewers.

[ Pablo Alexander Tenjo Villalba

[ Gerardo Tibana

Select review files to share with the author(s) Q, Search  Upload File

@ 31887 = Revista prueba de texto.docx Fin Y Article Text

i

[Required
Revista figura 1.png FieY Figures
Revista prueba de texto_v1.docx Fi. ¥

Select Library Files to attach

Next: Select Files for Copyediting JCancel
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If the reviewers' recommendation is to reject the manuscript and you
agree, click on “Decline Submission.”

Request Revisions

Accept Submission

Decline Submission

An editable template will be displayed on the screen to notify the
author and the manuscript will be archived.

Decline Submission

Send Email
@ send an email notification to the author(s): Pablo Tenjo

© Do not send an email notification

B E B 7Y Lo dE

Pablo Tenjo:

‘We have reached a decision regarding your submission to Revista de la Academia Colombiana de Ciencias

Exactas, Fisicas y Naturales, "Editorial vi”.

Our decision is to:

+ Add Reviews to Email

Send to Reviewers
send a copy of this email notification by BCC to the following reviewers. This will reveal the author’s identity to the

[ Pablo Alexander Tenjo Villalba
O Gerardo Tibana

Select review files to share with the author(s) Q Search  Upload File

v O B 31687 Revista prueba de texto.docx FjY Article Text
Required)

» O B 31622 Revistafigura 1.png FiY Figures

» O @ 31639 Revista prueba de texto_vi.docx Fj Y

Record Editorial Decision ~ Cancel
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